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WinCanvas(TM), Copyright (c) 1992, Roy Terry, All Rights Reserved.

Notice: Before using this software, you should carefully read the Disclaimer of Warranty and
License Agreement sections.    Use of this software indicates your acceptance of those terms 
and conditions. 

Select from the following list of topics for more information...

Summary of Features
WinCanvas Overview
Menu Functions
Keyboard Functions
Mouse Functions
Selection Lists
List of Tables
MIDI Interface
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File Menu
New    [Ctrl+N]

Creates a new, empty set of tables with all cells blank.

Open    [Ctrl+O]
Displays an open file dialog for loading a new WCV file.

Save    [Ctrl+S]
Displays a save file dialog for saving current tables to a WCV file.

Exit    [Ctrl+Q]
Closes the WinCanvas application.



Edit Menu
Edit:(set of tables) 

Defines the set of tables used by all other editing commands.    This set of tables is 
selectable from a sub-menu of three choices:

- Current Table    (the currently active table only)
- Opened Tables    (all opened, 'normal' tables)
- All Tables    (all available tables)

Note: This item is maintained in the INI file for future sessions.

Show Selection List    [F2]
Opens the Selection List for the currently selected table.    (Disabled when a list is not 

available.)

Copy -> MIDI Out    [Ctrl+M]
Creates sysex commands for all non-blank cells in the current selection range, and then 

transmits the commands to the MIDI port. 

Copy -> Sysex File    [Ctrl+F]
Creates sysex commands for all non-blank cells in the current selection range, and then 

opens a save file dialog for saving the commands to a standard Sysex format file. 

Copy -> Clipboard    [Ctrl+C]
Creates sysex commands for all non-blank cells in the current selection range, and then 

copies the commands to the clipboard in Hex/ASCII format. 

Paste Defaults    [Ctrl+V]
Inserts factory default values into all cells in the current selection range.

Clear Selected    [Ctrl+X]
Removes data from all cells in the current selection range.

Select All    [Ctrl+A]
Sets the selection range to all cells of the current table set.

Deselect All    [Ctrl+D]
Resets the selection range to the first cells of the current table set.



MIDI Menu
Open/Close 

Displays an open file dialog for selecting a standard MIDI format song file, or closes the 
currently selected MIDI file.

Play/Pause    [F3]
Starts playback of the current MIDI file, or pauses a currently playing MIDI file.

Rewind    [F4]
Resets playback of the current MIDI song file to the beginning, and restarts playback if 

the Loop item is checked.

Loop 
When this item is checked, the song file will automatically rewind and restart playback 

after completing.    This function will remain in effect until the menu item is unchecked.    
Note: This item is maintained in the INI file for future sessions. 

Thru 
When this item is checked, the MIDI Thru capability is active.    Any notes played on a 

keyboard connected to the currently defined MIDI Interface input port will be passed to the 
curent MIDI output port for playback.    Note: This item is maintained in the INI file for future 
sessions.



Setup Menu
Save Arrangement

Saves the current window arrangement for later recall.    This item opens a sub-menu of 
currently defined arrangements.    Selecting an existing arrangement from the list will cause 
the current window arrangement to replace that previously defined arrangement.    Selecting
the <new> item from the list will open a dialog for entering a name for this newly defined 
arrangement.    To recall saved arrangements use the 'Arrange' item from the Window Menu.  
Note: Each custom arrangement saves the layout of the application window and all table 
windows (sizes, positions, states, and fonts), as well as the current window focus.

Save Tone 
When an entire column of the Tone table is selected, this function will be enabled.    To 

save parameter settings with a tone:
- Highlight a single column of the Tone table,
- Select this function.

All highlighted parameter settings will be saved with the column's current tone (blank cells 
will be ignored).    To load saved settings into a column of the Tone table, use the Tone 
Selection List.    To erase the saved settings for a tone:

- Clear all values from a column,
- Enter the desired tone (bank and number) into that column,
- Hightlight the column,
- Select this function.

All saved settings for that tone will be erased.

Move Row 
When an entire row of a table is selected, this function will be enabled.    To move a row 

within a table:
- Highlight a single row of a table,
- Select this function,
- Click at the new row location.

The selected row will be moved to the new location.    This new row ordering only effects the 
current WCV file, which must now be saved to preserve the new row order.    To make a new 
default row ordering, load the startup WCV file and make the changes to that file, then save 
those changes using the File Menu.

Set File Paths
Displays a dialog for entering default paths for the startup WCV file as well as each of the

three file types used by WinCanvas: WCV files, Sysex files, MIDI song files.

Set MIDI Ports
Displays a dialog for selecting the MIDI input and output ports.

Set Font 
Displays a dialog for selecting the font type, style, and size used in the tables.



Keyboard Functions
The following keys are active in the Tables:

0...9 Data entry*
+ Increment current cell value by 1
- Decrement current cell value by 1
] or * Increment current cell value by 10
[ or / Decrement current cell value by 10
Enter Send current cell value to MIDI Out
Escape Clear cell
Backspace Delete character
Cursor Key Change focus by row/column
Shift-Cursor Set cell selection range

*Note: To enter a negative number, first clear the cell, then type '-' followed by the number.

The following keys are active in the Selection Lists:
a...z Move to the next line that begins with this letter
A...Z Move to the previous line that begins with this letter
+ Move to the next line in the list
- Move to the previous line in the list
] or * Move forward by 10 lines in the list
[ or / Move backwards by 10 lines in the list
Enter Select the current line and enter its value in the current cell of the 

table
Escape Close the Selection List

The following Function keys execute various Menu commands:
F1 Help / Index
F2 Edit / Selection List
F3 MIDI / Play/Pause
F4 MIDI / Rewind

The following Control keys execute various Menu commands:
Ctrl+N File / New
Ctrl+O File / Open
Ctrl+S File / Save
Ctrl+Q File / Exit
Ctrl+M Edit / Copy -> MIDI Out
Ctrl+F Edit / Copy -> Sysex File
Ctrl+C Edit / Copy -> Clipboard
Ctrl+V Edit / Paste Defaults
Ctrl+X Edit / Clear Selected
Ctrl+A Edit / Select All
Ctrl+D Edit / Deselect All



Disclaimer of Warranty
The software program and documentation for WinCanvas are being offered for evaluation

purposes "as is" and without warranties as to performance or merchantability.    By using 
WinCanvas, you are expressly releasing the author, Roy Terry, from any liability resulting 
from the use of this software and documentation.    The user must assume the entire risk of 
using this software.    Because of the diversity of hardware and software environments under 
which this software may be used, no warranty of fitness for a particular purpose is offered.



License Agreement
WinCanvas is being distributed as Shareware.    This software is not free.    You are 

granted a limited license to evaluate the Unregistered Version of WinCanvas for a period not 
to exceed 30 days.    After 30 days, you must either register your copy of WinCanvas with the
author, or immediately discontinue its use and remove it from your computer.    Use of the 
Unregistered Version of WinCanvas after the 30-day evaluation period is in violation of 
federal copyright laws.

You may make as many backup copies of WinCanvas as you wish, but you may not run 
WinCanvas simultaneously on more than one computer.    Additionally, you are granted the 
right to share the Unregistered Version of WinCanvas with others, as long as you distribute 
the WinCanvas archive exactly as you received it, with all associated files included.

Distribution of your Registration Number to others is strictly prohibited.

Under no circumstances may you charge a fee or receive any other form of consideration
for distributing WinCanvas without express written consent from the copyright holder, Roy 
Terry.



Registration Info
The registration fee for WinCanvas is $40.00.    This fee entitles you to use of the current 

version of WinCanvas, as well as all future shareware versions.    A Registration Number will 
be sent to you via First Class Mail (and via CompuServe Email, if possible) upon receipt of 
your registration form and fee.    This Registration Number, along with your Registration 
Name, will allow access to all the available features of WinCanvas.    If you would like a copy 
of the software on disk, include $5.00 to cover shipping costs.

A registration form (REGISTER.TXT) is included in the WinCanvas archive.    To register via 
US Mail, please send a completed copy of this form along with a check or money order for 
$40.00 (or $45.00 for registration and disk ) payable to: 

Roy Terry
2002 Pritchard Point Dr.
Navarre, FL 32566.

If you have a CompuServe account, you may also register WinCanvas on-line.    
Instructions for on-line registration are available by typing 'GO SWREG'.    Your CompuServe 
account will be automatically billed $40.00, and your Registration Number will be sent to you
via CompuServe Email. (A registration letter will follow via First Class Mail).



Summary of Features
WinCanvas is a Windows 3.1    editor/librarian for all Roland Sound Canvas series sound 

modules (and other compatible products).    It can be used either as a standalone 
application, or as a utility for Windows sequencers that support MME and the Clipboard, 
including Cakewalk for Windows, Master Tracks Pro for Windows, and WinJammer.    The 
major features of WinCanvas include:
 
    - Supports all GS-compatible sound sources (SCC-1, SC-55, SC-155, JV-30, etc.)
    - Microsoft Windows 3.1 MME application
    - Multiple spreadsheet-style windows for easy viewing and editing
    - Context sensitive help (factory defaults, min/max ranges, selection lists)
    - On-line Windows Help facility
    - Define custom defaults for window layouts, file paths, and MIDI ports
    - Play standard MIDI song files while changing settings
    - Edit Master, Reverb & Chorus global settings
    - Edit Part settings for each of the 16 Parts
    - Send user selected settings directly to the MIDI port
    - Copy user selected settings to the Windows clipboard*
    - Save user selected settings to MIDIEX format files*
    - Save user selected settings with each Tone*
    - Save all settings to files for later reloading and editing*

        * Registered version only



List of Tables
Sound Canvas parameter settings are grouped by category in separate spreadsheet-style

tables within WinCanvas.    The following list defines the parameters currently supported by 
WinCanvas:

Master Table:
Reset Volume
Pan Key Shift

Reverb Table:
Type Pre-LPF
Level Send Level
Delay Feedback Time
Character

Chorus Table:
Type Pre-LPF
Level Send Level
Feedback Delay
Rate Depth

Tone Table (Parts 1-16):
Mute/Solo Channel #
Tone/Drum Tone Bank
Tone Number Volume
Pan Reverb
Key Shift Chorus
Key Range Low Mono/Poly Mode
Key Range High Assign Mode
CC1 Controller Vel Sense Depth
CC2 Controller Vel Sense Offset

 
Filter Table (Parts 1-16):

Vibrato Rate TVF Cutoff Freq
Vibrato Delay TVF/TVA Env Decay
Vibrato Depth TVF/TVA Env Attack
TVF Resonance TVF/TVA Env Release

Controls Table (Parts 1-16):
Controller [Modulation, Pitch Bend, Channel Pressure, Poly Pressure, CC1, CC2]
Pitch Amplitude
LFO1 Rate LFO2 Rate
LFO1 Pitch Depth LFO2 Pitch Depth
LFO1 TVF Depth LFO2 TVF Depth
LFO1 TVA Depth LFO2 TVA Depth
TVF Cutoff

RX Table (Parts 1-16):
Prog Change Ctrl Change
Chnl Pressure Poly Pressure
Note Message Modulation
RPN NRPN
Volume Pan
Expression Hold1



Portamento Sostenuto
Pitch Bend Soft

Partial Reserve (Parts 1-16):
Voice Reserve



Mouse Functions
Table Functions:
 
Click (on data cell)

Sets focus to current cell.    Also resets select range to the current cell.

Click (on row/column header)
Sets select range to the entire row/column.

Shift Click (on headers or cells)
Adds new cells to current selection range.

Click and Drag (on headers or cells)
Sets select range to all cells included in drag operation.

Double Click (on data cell)
Opens Selection List for current cell, if list exists.

Selection List Functions:

Click (on item)
Copies Selection List data to appropriate cells in current Table, and copies the program 

change command to the MIDI Out port.

Double Click (on item)
Copies Selection List data to appropriate cells in current Table, closes the Selection List 

window, and copies the program change command to the MIDI Out port.



WinCanvas Overview
The WinCanvas editor/librarian is designed to act as a 'scratchpad' for editing Sound 

Canvas parameter values in an interactive fashion.    WinCanvas maintains a number of 
scratchpad tables for managing the various Sound Canvas parameters.    (The List of Tables 
section describes the parameters included in each table.) These tables are displayed as 
separate child windows within the application, and are designed as a two-dimensioned array
of data entry cells.    The display and arrangement of these child windows can be controlled 
from the Window Menu.

A complete set of tables is loaded from a single WCV format file, and any number of 
these sets of tables can be saved to WCV files via the File Menu.    For faster loading and 
saving, these files are saved in ASCII, tab-delimited format (not in binary sysex format).    
However, any portion of a table can be copied to a standard sysex format file via the Edit 
Menu.    Any portion of a table can also be copied to the clipboard in a Hex/ASCII format 
compatible with the sysex editors in several Windows-based sequencer programs (i.e., 
Cakewalk, WinJammer).    Additionally, any portion of a table can be copied directly to the 
MIDI port for auditioning parameter changes interactively.

All the commands in the Edit Menu are designed to operate on a selected range of cells 
from a specified group of tables.    A range of cells is selected by either mouse functions or 
keyboard functions, and the selected cells are shown highlighted in the table.    The edit 
commands can be set to act on only the current table, all opened tables, or all tables 
simultaneously.    Selection Lists associated with the current table can be shown from this 
menu as well.

Parameters are entered into the tables by either directly typing in numeric values (in 
decimal), or by using keyboard functions (+,-,etc.) to increment or decrement the current 
value.    Context sensitive help information for the current parameter is shown in the status 
bar.    Parameters which have a pre-defined list of valid entries (such as the tone settings) 
may also be entered by selecting their textual descriptions from pop-up Selection Lists.

To audition parameter changes interactively, the MIDI Menu can be used to play standard
MIDI song files.    A song file can be played while various parameter changes are copied to 
the MIDI port.    In addition, a MIDI Thru capability is available for playing a keyboard while 
making parameter changes with WinCanvas. 

The Setup Menu allows for the saving of multiple window arrangements for later recall, 
setting the default file paths for the various files used by WinCanvas, setting the MIDI 
Interface input and output ports, and setting the font used by the tables.    This menu also 
includes functions for re-ordering rows of the tables, and for saving selected parameters 
with each individual tone.



Table
A child window within WinCanvas used for displaying and editing Sound Canvas parameters. 
A Table can be moved, resized, minimized, and restored using standard Windows mouse 
functions.    The Tables have the look and feel of a Windows/Excel spreadsheet, with the rows
representing specific Sound Canvas parameters, and the columns representing the 16 voice 
parts available in the Sound Canvas (where applicable).    Most standard Excel 
mouse/keyboard functions are supported by the WinCanvas Tables.



Cell
A single data entry location in a table.



Selected Range
A group of cells in the active table that has been selected by either a mouse click/drag or a 
shift/cursor key movement.    The Selected Range is displayed as a block of highlighted cells.



MIDI Interface
WinCanvas will support all MME compatible MIDI drivers.    The MIDI Ports dialog allows 

separate selection of multiple MIDI output ports and one MIDI input port.

If you are using the default MPU driver that came with Windows 3.1, you will be able to 
use the MIDI playback functions of WinCanvas if it is the only MIDI application loaded.    (This 
is a limitation of the driver, not WinCanvas - Microsoft's driver does not support shared 
access.)    You can still load WinCanvas and another MIDI application, such as a sequencer, 
and copy sysex messages from WinCanvas to either a file, or the clipboard for pasting into 
your sequencer.

If you have a shareable MIDI driver (such as the Twelve Tone MPU driver included with 
Cakewalk for Windows, or the MQX driver from    Music Quest), you will have the full 
functionality of WinCanvas available while running your sequencer.    You can load and play a
song file with your sequencer, and then switch to WinCanvas and copy sysex messages 
directly to the MIDI port to audition Sound Canvas changes interactively.



Selection Lists
Selection List pop-up windows are available for the following Tables/Parameters:

- Reverb / Macro
- Chorus / Macro
- Controls / Control Type
- Tone / Tone Bank & Tone Number (& saved settings)

To open a Selection List, either double-click on one of the settings listed above, or single-
click on the setting and press 'F2', or single-click on the setting and select the 'Show 
Selection List' item from the Edit Menu.    The Selection List is a floating window that will stay
on top of the current table until it is closed from its Close Box, or a different table is selected.
A single-click on one of the items in the Selection List will copy that value into the currently 
selected column of the table, and keep the Selection List open.    A double-click on one of the
items will copy that value to the table and also close the Selection List.    In addition, the 
selected values will be automatically copied to the MIDI Out port.

The Tone and Rhythm Selection Lists have the additional functionality of loading other 
parameter settings along with each tone or rhythm value.    To load saved settings along with
the Tone Bank and Tone Number, select the radio button 'All Saved Values', then click on the 
desired tone name, and all saved settings will be copied to the Tone table.    Selecting the 
radio button 'Tone/Bank Only' will ignore any saved settings for the tone, and just load the 
tone bank and tone number.    Parameter settings can be saved with each Tone/Rhythm value
by selecting the 'Save Tone' item from the Setup Menu.



Status Bar
The Status Bar appears at the bottom of the WinCanvas window and displays the following 
context sensitive information:

Parameter | default value | valid range | descriptive notes



Menu Functions
File Menu 
 Commands for managing the WCV data files.

Edit Menu 
 Commands for editing the cells of the tables.

MIDI Menu 
 Commands for playing MIDI song files.

Window Menu 
 Commands for arranging the table windows.

Setup Menu 
 Commands for changing default settings.

Help Menu 
 Commands for accessing the Help system.



Window Menu
Arrange

Sets the arrangement of all windows using pre-defined layouts.    This item opens a sub-
menu of all available custom arrangements.    To add new arrangements to this list, use the 
Save Arrangement item from the Setup Menu.    Note: The 'Default' arrangement will always 
be available, even if no custom arrangements have been saved.

Tile
This item will tile all opened windows using the standard Windows tiling format.

Cascade 
This item will cascade all opened windows using the standard Windows cascade format.

Close All
Minimizes all opened windows to icons.

Arrange Icons 
Arranges all iconized windows along the bottom of the WinCanvas window.

Windows [1-8] 
Selecting one of the window names listed here will open that window and bring it to the 

top of all other opened windows.



Help Menu
Index    [F1]

Displays the WinCanvas Index help screen.

Overview
Displays the WinCanvas Overview help screen.

Register...
Displays a Registration input dialog.    To turn on the full functionality of WinCanvas, enter

the Registration Name, Address, and Number you received after registering your copy of the 
program.

Info... 
Displays the following status information:
- Current version of WinCanvas
- Current version of MIDILIBX.VBX
- Current version of MIDILIB.DLL
- Currently opened WCV file
- Currently opened MIDI file
- Currently selected MIDI configuration

About...
Opens the WinCanvas logo dialog.




